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Introduction 

 
The Gorilla Expense application allows three different types of users to be setup in the system –  

• Employee 

• Manager 

• Admin 
 
This guide describes the various tools and functionalities available within the application for an ADMIN 
type user. During the initial setup of the application, Gorilla Expense will create an ADMIN type user. 
Typically, this account will be accessed by the ‘gatekeepers’ within a company (typically - IT, Accounting, 
Accounts Payable, Finance etc.). It is recommended for the ADMIN to use this guide in conjunction with 
the User’s Guide to get a full understanding of the application.   

Accessing the Account 
 

The Gorilla Expense web application is accessible from anywhere as long as there is an internet 
connection. Every company is provided a unique URL to access the application. During the 
implementation process, users are setup in the system including an admin account. A unique username 
and password is provided to access the admin account.  
 
Once the admin is logged in using the credentials provided, the admin is provided with a dashboard 
screen as shown in Figure 1.  

 
Figure 1 
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At the top are the main buttons and functions. By clicking on Manage Users, a user list screen will open 
from where the profiles of all user’s setup in the application can be edited. The Analytics button opens the 
reporting page from where reports can be run. All the buttons on the left expand into additional 
functions. These are described below. 
 

Analytics 
By clicking on the Analytics button, two expense report related functions are available – Query Expenses 
and Reports. 
 

Query Expenses 
As the name suggests, the Query Expenses runs a query for all expense reports processed within the 
system. The results can be filtered per different parameters such as Report Type, Confirmation Number 
(which is the expense report confirmation number), Start & End Dates, Class/Customer or Job Number 
fields, Expense Status and by Employees. Figure 2 shows an example of various reports that have been 
queried in the system. 
 

 
Figure 2 
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Figure 3 

 
 
From the list of reports queried, each report can be opened by clicking on the Report Name. Once opened 
additional action can be taken. Figure 3, below, shows the screen once the report is opened.  
 
The three different areas that the admin can take action with are shown in Figure 3 at the top of the page. 
The admin can choose to Update Status, Redirect Expense or Edit Report. 

Update Status 

 
The update status function is used to change the status of the report from the current one to a new one. 
The admin can also add comments to describe the change. It is mandatory to enter comments, but we can 
configure to make it not mandatory. Please contact Gorilla Expense, if you would like to make this field 
non-mandatory. The update status field is a drop down menu with a list of typical statuses, as shown in.   
       
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 

  

Figure 4 
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The admin may pick the desired status from the list and click on the Submit button to change the report 
to that particular status. The only exception is when a report is to be ‘Rejected’. In that case, the Reject 
button must be clicked. Typical Reject statues include Manager Rejected and AP Rejected.  
 
Note that once the status of a report is changed, the application will initiate the respective alert for that 
status. For example, if a report is rejected, the application will send an email to a user noting that the 
report has been rejected (and include comments by the admin, if any). Similarly, if the status of a report is 
changed to Submitted to Manager, the respective manager will receive an email to take action for the 
report.  
 

Redirect Expense 

 
The admin can also choose to redirect the expense report to another manager setup in the system. This is 
done by selecting the redirected manager from a drop-down list as shown in Figure 5 and clicking on the 
Redirect button. Note that reports can only redirected to other managers in the system. 
 
 

 
 

Figure 5 

 

Edit Report 

 
The admin can also choose to edit a user’s report by clicking on the Edit Report button at the top right as 
shown in Figure 3. After clicking this, the admin will be presented with the expense report just as a user 
would see it in order to make changes. Note that only existing transactions created by a user can be 
edited. New transactions cannot be created by the admin. If a new transaction is to be added to the 
report, the admin may both copy an existing transaction and make changes to the copied transaction or 
the admin may reject the report and request the user to add the new transaction.   
Once the changes are made to the report, the admin can validate the report. Once validated, the admin 
can click on the Back to Review Expense button at the top left to go back to the original Status screen 
from where next steps can be taken.  
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Additional Tools 

 
Within the status page of a report as shown in Figure 3, the admin also has access to additional tools such 
as the PDF preview function and Audit Trail. The PDF Preview when executed creates a comprehensive 
PDF with all the relevant information from the expense report. The layout of the PDF includes a table on 
the first page with all the transaction details, including information from the header level of the expense 
report such as a user’s name, date range of the report, status of report, comments etc. The subsequent 
pages show all the receipts submitted as part of the report. Each receipt page begins with the expense 
type information followed by the date of the transaction. The PDF report itself can be saved or printed 
just as a typical PDF document. 
 
The Audit Trail functionality provides a dynamic logging of data entries and modifications. The 
information includes a brief description of the change as well as a date and time stamp at both the header 
and transaction levels. The Audit Trail screen displays the expense report confirmation number, start and 
end dates, project information, comments, status and user at the header level. It includes the expense 
report confirmation number, transaction ID, receipt status, expense type, date of transaction, amount, 
city, comments and user at the transaction level. Once the data logging is complete, the admin can choose 
to save the Audit Trail as a PDF, Word document or Excel document from within the screen. 
 

Reports 
 

Here, the application provides a canned set of reports for the admin to run. These reports provide a 
summary of results pertinent to the selected report type. Typically, the admin can filter the available 
results by selecting a start and end date and then Executing the report. Once the report has compiled and 
made itself available to the admin, it can also be saved as a PDF, Word document or Excel document . 

 

Integration 
 

The integration button provides two functions – Generate CSV and Upload CSV. As the name suggests, the 
Generate CSV creates a CSV flat-file. Once generated, this file can then be imported into or used in 3rd 
party systems such as Accounting or Payroll to complete the data flow and initiate next step actions for 
the company. 
 
Prior to generating the file, the data to be included can be filtered based on Start and End Dates and 
statuses within the application. Typically, only reports that have a manager approved status associated 
with them are included in the CSV file. But other statuses can also be included. When generating the csv, 
the admin may choose to update the status of the reports to either “AP Approved”, “AP Paid” or “AP 
Submitted” within Gorilla Expense. When this done, the status of the reports is changed and also visible to 
users and managers in the system. Depending on requirements, specific CSV templates can also be 
generated by Gorilla Expense. Contact us for more details.  
 
The Upload CSV allows for flat files to be imported into Gorilla Expense to update statuses based on 
completed actions from other systems. For example, if Accounts Payable has issued reimbursements for 
various expense reports, a CSV file from the payroll system can be imported here to update the status of  
these reports within Gorilla Expense to ‘AP Paid’.  
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Settings 
The Settings button lists a few functions are that related to the admin account within the application.  
 

Your Profile 
 

The Your Profile screen includes information pertinent to the admin user. The items shown here are a 
user Code and Vendor Number, the First and Last Name and finally the Email address of the admin. Note 
that this email does not have to be a functional email 

Credit Card Profile 
 

The Credit Card Profile function lists the banking information of the user that has been set up in the 
application. With the help of the bank information corporate card transactions can be automatically made 
available to the users. This function will help the admins in creating and editing the Credit Card profiles of 
the users. The initial screen, as shown in below figure shows a list of users with their Credit Card profiles.  
At the bottom of the page is a Create New button. This can be used to create a new profile 
 

 
Figure 5a 

Search button  

Profiles already existing in the system can be searched with the user’s name using the search button. 
Below screen (Fig 5b) shows the search process of users 

 
Figure 5b 
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Create New  
 

The basic information for all users is shown in this view (Figure  5c) such as – user name, profile name, 
bank name, account number, account type, routing number, not reimbursable, default and action  
If any of these parameters are to be changed, the admin can click on the Action icon. Once clicked  the 
view is as shown below in Figure 5c. 
 

 
Figure 5c 

 
To create new Credit Card profile below Table offers a brief description of the various fields 
 

 Field Description Validation Mandatory 

User Name  This is the user’s name as defined in the system  Existing users in 
the system 

Yes 

Profile Name This is the profile name  Alphanumeric, 
with special 
characters 

Yes 

Bank Name This is the bank name as defined in the system Existing names in 
the system 

Yes 

Account 
Number 

This is the account number Alphanumeric, 
with special 
characters 

Yes 

Account Type This is the account type  Select either one Yes 
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of the following 
Checking, Savings 
or Credit Card 

Routing 
Number 

This is the routing number  Alphanumeric, 
with special 
characters 

Not 
mandatory 
for credit 
card 

Country  If this field is enabled User can provide default 
value that will be populated when a transaction is 
imported from the bank field. This default value will 
not be set on the created transaction if the bank 
feed contains the corresponding value  

Existing in the 
system 

Configurable 

State  User can choose state from the dropdown Existing in the 
system 

Configurable 

City User can enter the details Alphanumeric, 
with special 
characters 

Configurable  

Default 
Currency 

This is as configured under Masters-> Currency Existing in the 
system 

Yes 

Default Pay 
Method 

This as configured under Masters-> Pay Method Existing in the 
system 

Yes 

Not 
Reimbursable 

Whether this profile is not reimbursable  Check box Yes 

Default account Whether this account should be made default Check box No 

Other 
Coworkers 

User can choose other coworkers as configure in 
the system 

Alphanumeric, 
with special 
characters 

No 

Other 
Comments 

Field for additional comments Alphanumeric, 
with special 
characters 

No 

Company If this field is enabled User can provide default 
value that will be populated when a transaction is 
imported from the bank field 

 Configurable 

Business Unit If this field is enabled User can provide default 
value that will be populated when a transaction is 
imported from the bank field 

 Configurable 

Cost center If this field is enabled User can provide default 
value that will be populated when a transaction is 
imported from the bank field 

 Configurable 

Credit Card 
Scheme 

If the Credit card Scheme is configured then it can 
be selected the added scheme through this field 

 No 

 
Edit Credit Card Profile - The pencil icon is for editing the Company 
Delete Credit Card Profile - The Red X is to delete the Company entry 

Change Password 
 

This feature allows the admin user to change the password by entering the old password once and the 
new password twice. This is possible only when the admin knows his current password and wishes to 
change it else, he can use “Forgot Password” link in the login screen.  
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Figure 5d 

Impersonate User 
 

This feature is used to assume pseudo or proxy identities of actual users to complete the tasks on their 
behalf. It is mostly applicable for users or travelers who have personal assistants e.g. A VP of a large 
organization would have a personal assistant, for such users it would be simple and easy if expenses are 
also handled and done by their assistants as all the details are readily available with them. Prior to 
impersonating/assuming identity of the actual users a mapping of the users is done by the admin (for 
details refer to “Impersonate User Mapping section”). Post mapping the pseudo/proxy users can 
impersonate the mapped users in the system and complete all the tasks on behalf of the actual users like 
creating transactions, creating and submitting reports, and other tasks as per the user type configured in 
the system. On completion they can revert back to their own identity using the “Revert Identity” link. 
 
Some of the advantages of this feature are when travelers are busy on travel and clocking business 
pseudo users can assume their identity and complete the tasks for them which will lead in cutting down 
delays for submitting and approving expenses and pushing them to the accounting system for final 
closure. In case of any required edits or changes or troubleshooting the AP Admin can connect with the 
impersonating user and do the needful as required. 
 
Below figure shows the list of users with the “Impersonate User” action link (Figure 5e). 
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Figure 5e 

 
On clicking the above button, the user impersonates the mapped user (Alex Jones). The user will be 
presented the below screen (Figures 5f). The entire experience and screen layout/functionality is very 
similar to how it will be if Alex Jones himself would have logged in.  
 

 
Figure 5f 
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The only difference is that there is “revert Identity” link at the top, using which the application reverts the 
identity back to the original user. The user will be first asked if he/she intends to revert identity (figure 5g)  
 
 

 
Figure 5g 

 
Once the user confirms, the application goes back to the home screen of the original user (Figure 5h). 

 
Figure 5h 

 
 

Impersonate User Mapping  
 

This feature is available under Settings -> Impersonate User Mapping menu. With this feature users are 
mapped to the users they can impersonate or assume pseudo identity of the actual users. To do the 
mapping the admin has to go to the Impersonate User Mapping screen and toggle single/multiple users 
from the unassigned user’s list box to the Assigned user’s list box and vice a versa, on hitting save the 
users in the assigned list can impersonate the user selected from the user drop down.  So now when the 
assigned user’s login to the application and go to Settings ->Impersonate user they should be able use the 
impersonate user functionality by choosing the impersonate user action link (for more details refer to 
“Impersonate User” section).       
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Figure 5i 

 

Reminders for Expenses  

 
Reminders helps you in reminding the Employees for certain actions they must perform within the system 
like submitting or approving expense reports within a certain timeline. Imagine a way to let your busy 
Employee know about a pending expense report submission or a manager who needs to approve an 
expense to facilitate timely reimbursements. To achieve all this and much more, go to Settings > 
Reminders. 
 
Based on the business needs, let us see how and what type of reminders can be configured:  
There are 5 types of reminders 

• Not Created and Pending Submission Reminder – Reminds end-users to create and submit an 
expense report at least once during a predefined time period (weekly, bi-monthly, monthly) 

• Created Not Submitted Reminder – Reminds end-users to submit expense reports that have been 
created more than a pre-defined number of days ago 

• Pending Approval Reminder – Reminds end-users to approve expense reports that are awaiting 
their approval since more than a pre-defined number of days 

• Unsubmitted Bank Transaction Reminder - Reminds end-users to complete credit card 
transactions imported from the credit card feed and assign them to a report. Reminders are sent 
if the end-user has not done so after a pre-defined number of days have passed since the 
transaction was imported into Gorilla Expense 

• Pending Approval Reminder (Escalation) - This type of reminder is designed to trigger the 
escalation reminder if the manager does not approve the reports for "Predefined Number of 
Days" since it was submitted. This escalation email is sent to the escalation contact maintained on 
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the user’s profile whose expense has not been approved by his manager for more than the pre -
defined number of days. 

 
 
Not Created and Pending Submission: 
 
Use this option to remind an employee if no reports are created within a predefined period (weekly, bi-
monthly or monthly) after a set number of “Predefined” days have passed This is particularly useful for 
customers who require their employees to create at least one expense report every week or every two 
weeks or every month. 
For example, a user can be reminded to create an expense report if he hasn’t created an expense report 7 
days after month-end in case you configure the pre-defined mandatory submission period to be once 
every month. Once the condition is met, the system will continue to send a reminder every day till the 
user creates an expense report for that month. Follow the following steps to configure this type of 
reminder- 

• Login to the application with the admin credentials 
• Go to Settings -> Reminders and click on Create New 

 
 Fill out the details as follow: 
 

 
Figure 5j 
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Reminder Configuration 
 
Reminder Type               :               Expense 
Name                               :               Reminder for Not Created and Pending Submission 
Category                         :               Not Created and Pending Submission 
Scheduler Type             :               Reminder 
To                                    :               #User (This will send the reminder to the user. The hashtag user will be 
replaced by the user’s email address)  
CC                                   :               #Manager (This will CC the manager the hashtag manager will be replaced 
by the manager’s email address) 
Email Subject                :               #FirstName #LastName you have not created an expense report for the 
last #DurationInActionDays days (This can be any email subject you desire to have – the hashtags will be 
replaced by actual values. Refer the table below to understand which hashtags are available to be put 
in the Email Subject) 
Email Body                    :               Greetings, #FirstName #LastName, you have not created an expense 
report for the last #DurationInActionDays days. Please visit the following link to create any outstanding 
expense report- #ApplicationLink <br>Regards, <br>The Gorilla Expense Team (This can be any email body 
you desire to have – the hashtags will be replaced by actual values. Refer the table below to understand 
which hashtags are available to be put in the Email Body) 
 
Duration InAction Days    :               7 
Recurring Panel (e.g. Set to remind the user everyday) 
Repeat                            :               Daily 
Every                              :               1 Days 
Stats On                          :               6/1/2017 
Ends On                          :               Never 
 
The following hashtags are available for “Not Created and Pending Submission” type of the reminder:  
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Created and Pending Submission 
 
This type of reminder is designed to remind any user who has an expense report that was created but 
never submitted after a pre-defined number of days have passed. So, for example, you could use this 
reminder to remind a user who has a report ending on 30th June, but has not submitted it for another 7 
days (which is the pre-defined configurable value) till 7th of July. So, on 8th July, a reminder email would 
be sent. This email could again be sent as per the recurring schedule defined on the reminder job. 
Reminder email will be sent only if the criteria described above is met. 
 

 
Figure 5k 

 
 
Reminder Configuration 
 
Reminder Type                :               Expense 
Name                               :               Expense Report Created But Pending For Submission 
Category                          :               Created and Pending Submission 
Scheduler Type                :               Reminder 
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To                                     :               #User (This will send the reminder to the user. The hashtag user will be 
replaced by the user’s email address)  
CC                                    :               #Manager (This will CC the manager the hashtag manager will be replaced 
by the manager’s email address) 
Email Subject                   :               #FirstName #LastName There are expense reports pending for 
submission! (This can be any email subject you desire to have – the hashtags will be replaced by actual 
values. Refer the table below to understand which hashtags are available to be put in the Email Subject) 
Email Body                          :         Greetings,<br><br>#FirstName #LastName, You have not submitted bank 
transactions for the last  #DurationInActionDays days.<br><br>Please visit the following link to submit any 
outstanding expense bank transactions-<br> #ApplicationLink <br><br> #Details 
<br><br>Regards,<br>The Gorilla Expense Team (This can be any email body you desire to have – the 
hashtags will be replaced by actual values. Refer the table below to understand which hashtags are 
available to be put in the Email Body) 
 
Duration InAction Days         :               7 
Recurring Panel (e.g. Set to remind the user everyday) 
Repeat                                 :               Daily 
Every                                   :               1 Days 
Stats On                               :               7/7/2017 
Ends On                                :               Never 
 
The following hashtags are available for “Created and Pending Submission” type of the reminder:  
 

 
 
 
Pending Approval Reminder: 
 
This type of reminder is designed to look for any expense report that has not been approved since more 
than "Predefined Number of Days" since it was submitted. This email could again be sent as per the 
recurring schedule defined on the reminder job. A reminder email will be sent only if the criteria 
described above is met. 
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Figure 5l 

 
Reminder Configuration 
 
Reminder Type                 :               Expense 
Name                               :               Reminder For Pending For Approval 
Category                           :               Pending Approval Reminder 
Scheduler Type                 :               Reminder 
To                                     :               #Manager (This will send the reminder to the manager. The hashtag user 
will be replaced by the manager’s email address)  
Email Subject                    :               There are expense reports pending your approval! (This can be any 
email subject you desire to have – the hashtags will be replaced by actual values. Refer the table below to 
understand which hashtags are available to be put in the Email Subject)  
Email Body                        :               Greetings,<BR>Reminder - There are expense reports pending your 
approval! Please login to approve the expense report. The details are as follows: #Details. The login URL is 
#ApplicationLink<BR><BR>Regards,<BR>Gorilla Expense (This can be any email body you desire to have – 
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the hashtags will be replaced by actual values. Refer the table below to understand which hashtags are 
available to be put in the Email Body) 
 
Duration InAction Days      :               7 
Recurring Panel (e.g. Set to remind the user every week on Monday) 
Repeat                              :               Weekly 
Every                                :               1 Week(s) 
Repeat On                         :               Mon 
Stats On                            :               7/3/2017 
Ends On                            :               Never 
 
The following hashtags are available for “Pending Approval Reminder” type of the reminder:  
 

 
 
Unsubmitted Bank Transaction Reminder: 
 
This type of reminder is designed to check if a user has any un-submitted transactions imported from the 
credit card feed that were imported more than the "Predefined Number of Days" ago, but not attached to 
an expense report. This “Predefined Number of Days” can be any number of days greater than 0. The 
reminder email could be sent as per the recurring schedule defined on the reminder job. Reminder  email 
will be sent only if the criteria described above is met. 
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Figure 5m 

 
Reminder Configuration 
 
Reminder Type                :               Expense 
Name                               :               Reminder For Unsubmitted Bank Transaction 
Category                          :               Unsubmitted Bank Transaction Reminder 
Scheduler Type                :               Reminder 
To                                     :               #User (This will send the reminder to the user. The hashtag user will be 
replaced by the user’s email address)  
CC                                    :               #Manager (This will CC the manager the hashtag manager will be replaced 
by the manager’s email address) 
Email Subject                   :               #FirstName #LastName have not submitted bank transaction for the last 
 #DurationInActionDays days (This can be any email subject you desire to have – the hashtags will be 
replaced by actual values. Refer the table below to understand which hashtags are ava ilable to be put in 
the Email Subject) 
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Email Body                       :              Greetings,<br><br>#FirstName #LastName, You have not submitted bank 
transactions for the last  #DurationInActionDays days.<br><br>Please visit the following link to submit any 
outstanding expense bank transactions-<br> #ApplicationLink <br><br> #Details 
<br><br>Regards,<br>The Gorilla Expense Team (This can be any email body you desire to have – the 
hashtags will be replaced by actual values. Refer the table below to understand which hashtags are 
available to be put in the Email Body) 
 
 
Duration InAction Days  :               7 
Recurring Panel (e.g. Set to remind the user every week on Monday) 
Repeat                               :               Weekly 
Every                                  :               1 Week(s) 
Repeat On                         :               Mon 
Stats On                             :               7/3/2017 
Ends On                             :               Never 
 
The following hashtags are available for “Unsubmitted Bank Transaction” type of the reminder:  
 

 
 

Pending Approval Reminder (Escalation): 
 
This type of reminder is designed to trigger the escalation reminder if the manager does not approve the 
reports for "Predefined Number of Days" since it was submitted. This escalation email is sent to the 
escalation contact maintained on the user’s profile whose expense has not been approved by his manager 
for more than the pre-defined number of days. This email could again be sent as per the recurring 
schedule defined on the reminder job. A reminder email will be sent only if the criteria described above is 
met. 
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Figure 5n 

 
Reminder Configuration 
Reminder Type                 :               Expense 
Name                               :               Escalation - Pending Approval Reminder 
Category                           :               Pending Approval Reminder (Escalation) 
Scheduler Type                 :               Reminder 
To                                    :               #EscalationContact (This will send the reminder to the escalation contact 
maintained on the user profile. The hashtag user will be replaced by the contact’s email address)  
CC                                    :               #Manager (This will CC the manager the hashtag manager will be replaced 
by the manager’s email address) 
Email Subject                     :               Escalation: The expense reports are not approved (This can be any 
email subject you desire to have – the hashtags will be replaced by actual values. Refer the table below to 
understand which hashtags are available to be put in the Email Subject)  
Email Body                         :               Greetings,<BR>Reminder - There are expense reports pending for the 
approval! The details are as followed: Please login to view the details. #Details. <BR>The login URL is 
#ApplicationLink<BR><BR>Regards,<BR>Gorilla Expense (This can be any email body you desire to have – 
the hashtags will be replaced by actual values. Refer the table below to understand which hashtags are 
available to be put in the Email Body) 
Duration InAction Days         :               7 
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Recurring Panel (e.g. Set to remind the user every week on Monday) 
Repeat                                 :               Daily 
Every                                   :               1 Day(s) 
Stats On                               :               6/16/2017 
Ends On                               :               Never 
 
The following hashtags are available for “Pending Approval Reminder (Escalation)” type of the reminder: 
 

 

Reset Password for all Users 

 
Admin user can reset the password for all the users or selected user(s) by choosing the “Reset Password 
for All Users” link on the settings page. On choosing this option an email notification is sent to all or 
selected user(s) regarding the password being reset. This functionality has made it easy for the admin to 
reset single or multiple user passwords on one screen with a few clicks.  
 

 
Figure 5o 
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Billing  
 

This functionality is not enabled by default. It is enabled only for users who are subscribing to our “Per 
Report” or “Per User” subscription. When the settings for this feature is successfully enabled, the "Billing" 
menu will be activated and visible for admin users only  
  
 

 
Figure 6 

 
Under "Billing" "Subscriptions" menu will be visible.  
 

Subscriptions 
In subscriptions the admin can see the report bucket subscribed, the available reports, used reports, the 
validity period, whether the subscription has expired or oversubscribed.  
 

 
Figure 6a 

 
The action button gives a detailed view of the reports consumed (stating the expense confirmation 
number, user, user email, vendor, company, BU and expense report status) the admin can export these to 
a PDF and excel. 
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Figure 6b 

 

 
Figure 6b 

 
Gorilla expense is responsible to add the subscription plan and validity details for the client. When the 
client admin logs in to the system, used reports and available reports are auto calculated by the system.  
 
The system also tracks the validity of the subscription plan and triggers 45and if it’s expired or 
oversubscribed. 
  
In such cases the emails are triggered to the configured email-ids in the system. 
  
These emails are triggered at the following intervals  

1. 45 days prior to expiry of subscription  
2. Used reports reach 80 percent of the total reports  

 

Masters 

The Masters button when clicked expands into multiple fields. This is where various parameters specific to 
different functions within the application are defined and stored.  During initial setup of the application, 
Gorilla Expense will setup certain parameters per the requirements of  the customer.  
 
The sub-sections are described as follows: 
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• User 

• Business Unit 

• Company 

• Cost Center 

User 
 

A user field provides a list of users that have been setup in the application. The initial screen, as shown 
below in Figure 6 is a list of all users in the system. At the bottom of the page is a Create New button. This 
can be used to create a new profile.  
 

 
Figure 7a 

 
 
 
Search button  
 
Profiles already existing in the system can be searched using the search button. Below screen (Figure 7) 
shows the search process of users 
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Figure 7b 
 
To search any user, follow the below steps 
 
1. Enter either all or any of the following 

a. User code 
b. First name 
c. Last name 
d. Select company name 
e. Select business 

2. Click on Search button  
3. List of users with similar search criteria will be shown. 
4. The list will also have disabled users  
5. The list can be navigated with Next, Previous, First and Last buttons 

Create New 
 

The basic information for all users is shown in this view (Figure 8) such as – User Code, First and Last 
Names, Email, Phone Number, Business Unit, Disabled status and Action. If any of these parameters are to 
be changed, the admin can click on the Action icon. Once clicked the view is as shown in Figure 8. Table 1 
offers a brief description of the various fields. 

 
Figure 8 

 

To add user, follow the rules mentioned in the grid below 
   

Field Description Validation  Mandatory 
User Code Enter employee HR code - this field is 

applicable if exporting expense data to a 
payroll system or importing data from Travel 
Booking Back Office System. If you are not 
going to do any of this, you can leave the field 
empty and it will be defaulted to Vendor 
Number  

Alphanumeric, 
with special 
characters 

Yes 
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Vendor Number Enter employee vendor number as specified in 
the ERP/Accounting system 

Alphanumeric, 
with special 
characters 

Yes 

First Name Employee First Name Alphanumeric, 
with special 
characters 

Yes 

Last Name Employee Last Name Alphanumeric, 
with special 
characters 

Yes 

Password By default, it is set to current “YYYYMM”. 
Example: “202105” 

 Yes 

Email Employee email address. This should be a valid 
email, as this will become the user's login 
username and be used for all future 
communications by the system 

Alphanumeric, 
with special 
characters 

Yes 

Phone Number This is the phone number of a user  Numeric  Optional 

Mileage Rate This has to be entered as a numeric value, it 
can vary for different user type like the mileage 
rate can be different for employee and 
manager or can be defaulted to a single value 

Numeric Yes 

Unit of Travel Select between Miles or KMS. This is used 
while calculating mileage distance between 
start and end address using Google Maps 

 Yes 

Address Line1 Enter User’s Address Line1. Field is typically 
disabled, but can be enabled or disabled if 
required. Similarly, if enabled, the field can be 
made optional or mandatory 

Alphanumeric, 
with special 
characters 

Configurable 

Address Line2 Enter User’s Address Line2. Field is typically 
disabled, but can be enabled or disabled if 
required. Similarly, if enabled, the field can be 
made optional or mandatory 

Alphanumeric, 
with special 
characters 

Configurable 

Address Country Enter User’s Address Country. Field is typically 
disabled, but can be enabled or disabled if 
required. Similarly, if enabled, the field can be 
made optional or mandatory 

Alphanumeric, 
with special 
characters 

Configurable 

Address State Enter User’s Address State. Field is typically 
disabled, but can be enabled or disabled if 
required. Similarly, if enabled, the field can be 
made optional or mandatory 

Alphanumeric, 
with special 
characters 

Configurable 

City Enter User’s City. Field is typically disabled, but 
can be enabled or disabled if required. 
Similarly, if enabled, the field can be made 
optional or mandatory 

Alphanumeric, 
with special 
characters 

Configurable 

Zip code Enter User’s zip code. Field is typically disabled, 
but can be enabled or disabled if required. 
Similarly, if enabled, the field can be made 
optional or mandatory 

Numeric Configurable 

User Type Categorize users as 'Manager' or 'Employee'. 
 Managers can create as well as approve 
expense reports. Employee type of user can 
only create and submit expense reports 

 Yes 

Role Assigned Enter different Roles as needed. (Roles are Alphanumeric, Yes  
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used to segment users. Users assigned to a 
specific Role will only see Expense Types and 
Report Types allocated to that Role). If none of 
this is applicable to you, just default to 
CORPORATE. For more details on the role 
function see Role below 

with special 
characters 

Assigned to Manager See Manager Approval section below this Table Valid email-id Yes  

Multi-Level Approval See Manager Approval section below this Table 
also see notes below the table 

Valid manager 
email-id who 
is existing in 
the system 

No  

Expense Status 
Before Approval 

The expense status before approval by a 
manager is typically set to Submitted to 
Manager See Manager Approval section below 
this Table 

 Yes  

Expense Policy Limit The amount of policy limit can be set here Numeric  No  

Timesheet Manager See Manager Approval section below this Table Valid email-id No  

Timesheet Status 
Before Approval 

The timesheet status before approval by a 
manager is typically set to Submitted to 
Manager 

 No  

Company Enter company name. If you have multiple 
companies, assign users to respective 
company. This field could be used to derive 
accounting segment information while 
integrating with GP or Dimension information 
while integration with NAV 

Alphanumeric, 
with special 
characters 

Yes 

Business Unit List business unit that user belongs to, if any. 
Else, default to NA. This field could be used to 
derive accounting segment information while 
integrating with GP or Dimension information 
while integration with NAV 

Alphanumeric, 
with special 
characters 

Yes 

Default currency Enter the 3 letters currency code the user gets 
reimbursed in. For example, USD or CAD 

Should be a 
valid currency 
present in the 
currency 
master  

Yes 

Cost center List cost center that user belongs to, if any. This 
field could be used to derive accounting 
segment information while integrating with GP 
or Dimension information while integration 
with NAV. 

Alphanumeric, 
with special 
characters 

Yes 

APGL Code Enter user specific Reimbursable AP GL code 
for user if applicable 

Alphanumeric, 
with special 
characters 

No 

User Group Enter user group that user belongs to, if 
applicable. This field could be used to derive 
accounting segment information while 
integrating with GP or Dimension information 
while integration with NAV 

Alphanumeric, 
with special 
characters 

No 

VAT1 GL Code Enter user specific VAT1 AP GL code, if 
applicable Else leave empty 

Alphanumeric, 
with special 
characters 

No 
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VAT2 GL Code Enter user specific VAT2 AP GL code, if 
applicable Else leave empty 

Alphanumeric, 
with special 
characters 

No 

VAT3 GL Code Enter user specific VAT2 AP GL code, if 
applicable Else leave empty 

Alphanumeric, 
with special 
characters 

No 

Team/Project If the user is assigned to a specific team or 
project then the options will be shown in the 
drop down 

Alphanumeric, 
with special 
characters 

No 

Disabled User By selecting Yes, a user will be disabled and will 
not be able to access their account 

Radio button No 

Save When save is clicked, a new user is created Action button   

Back to List This button will take the admin back to the 
user list  

Action link  

 
Table 1 

 
Note:  
Gorilla Expense offers two kinds of Manager Approval Workflows 
a) Manager approval by SIMPLE HIERARCHY - Here, employee submits it to MGR1 and after MGR1 has 
approved, it goes to MGR2.  
b) Manager approval by AMOUNT - Here, if employee submits a report whose with a value < $ expense 
policy type, then only MGR1 has to approve and it is done. If employee submits a report with a value > $ 
expense policy type, then after MGR1 approves, it will be sent to MGR2 for approval.  
 

Manager Approval 

Gorilla Expense can be setup to follow a multi-level manager approval process. The multi-level manager 
approval can be setup differently for different users. In this setup, multiple levels of manager approvals 
can be defined in the system by the admin and different managers can be assigned to these levels. This 
mechanism can be broken into two formats (only one format can be enabled at a time). They are:  
 
1) Multi-level Approval by Standard Hierarchy: In this mechanism, the multi-level approval process will 

follow a standard hierarchy as defined by the admin. For example, let’s say there  are two managers 
setup in the system, viz., Joe (Manager1) and David (Manager2). Joe 1 will be listed under ‘Assigned 
to Manager’ as shown in Figure 8a and David will be listed under the ‘Multi-Level Approval’ button as 
shown in Figure 8b. 
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Figure 8a 
 

 

 
 

Figure 8b 
 
In the example shown in Figure 8a and 8b, when a user submits an expense report, the report will first be 
submitted to Joe. Once Joe has approved the report, the status will be changed to Manager Approved. 
After this, the report will be routed to David. As seen in Figure 8b, the ‘Expense Status before Approvals’ 
for David is set to Manager Approved. Since David is the final manager,  once David approves, the status 
will change to “Manager Approved – All Levels” and the report is considered complete. 
 
Note that if there is only one manager (Manager 1) required for a particular employee but the company 
workflow still includes more than one level of manager approval statuses, then Manager 1 must be setup 
at both levels for that employee. This will ensure that the workflow is maintained and the email 
confirmation messages work correctly. In this case, Manager 1 will only need to approve the report once. 
And similar to the previous example, when the report is approved, the application will change the status 
to Manager Approved – All Levels. 
 
If additional levels of manager approval are needed, the admin must first create new statuses under 
Masters > Status. Once these statuses care created, they will be available in the ‘Expense Status Bef ore 
Approval’ drop down list shown in Figure 8b. From there, respective managers can be associated to the 
specific statuses. 
 
Here is a typical table for several layers of manager approval and the respective statuses as shown in 
Table 2 

 

Step Action Status in system Routed to 

1 Employee submits a report Submitted to Manager Manager 1 

2 Manager 1 approves report Manager Approved – Level 1 Manager 2 
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3 Manager 2 approves report Manager Approved – Level 2 Manager 3 (Final) 

4 Manager 3 approves report Manager Approved – All Levels - 

 
Table 2 

 
After step 4, the report will now be available to AP/Accounting to be pushed to the accounting system. 
Also, the employee will be intimated that the report has been approved at the final level.  
 

2) Multi-Level Approval by Expense Policy Limit: In this mechanism, the multi-level approval workflow will 
depend on the expense report amount setup for each user by the admin in the respective user’s prof ile . 
Depending on the amount defined, additional levels of approval will be activated. Compared to the 
standard hierarchy, a new field is available here, called ‘Expense Policy Limit’ as show in Figure 9a . Figure 
9b shows the next level of manager approval. 

 

 
Figure 9a 

 
Figure 9b 

 
In this example shown in Figure 9a and 9b, the expense policy limit has been set to $200 and the two 
managers are Joe (Manager1) and David (Manager2). Joe has been set in ‘Assigned to Manager’ f ie ld 
similar to Figure 8a (not shown in Figure 9a) and David has been set at the next level as shown in 
Figure 9b. Note that the report’s status will be ‘Manager Approved’ before David receives it, as 
defined in the ‘Expense Status Before Approvals’ list shown in Figure 9b. It is also important to enter 
the ‘Expense Policy Limit’ value here for the multi-level approval to work correctly. Logically, the value 
set here must match the value set in the previous page as shown in Figure 9a.  
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In this example, if a user’s expense report is less than $200, only Joe will need to approve the expense 
report. In this case, when Joe approves the expense report, the status will change to Manager 
Approved – All Levels and the report is considered to be complete. 
 
If the report amount is greater than $200 and it has been approved by Joe, the status will change to 
Manager Approved. Next, it will be routed to David for the second and final approval. After David has 
approved the expense report, the status will change to Manager Approved – All Levels and report is 
considered to be complete. Note that in cases where Manager1 and Manager2 are setup to be the 
same for a user, the application will intelligently change the status to Manager Approved – All Levels 
in order to prevent double approvals by the same manager. When the report is greater than $200, the 
employee will be alerted that multiple levels of managers will need to approve the report since the 
report’s value has crossed the $200 expense policy limit.  
 
Note that when the standard hierarchy format is selected, the Expense Policy Limit field will not be 
seen in a user’s profile.  

 

Bulk upload/update the users and assign manager/approver 
 

Using the Gorilla Integration app admin can bulk upload/update the user profiles and assign the 
managers/approver in the system. For more details on how to upload/update the user profiles and assign 
the managers/approver using the Integration app please click here. 

Bulk Redirect Expenses Pending Approval by Manager  
 

The Bulk redirect expenses functionality is used to redirect expenses pending approval by one manager to 
another manager by selecting the “Redirect Expenses” link on the Edit User screen, the redirected 
expenses can be approved on behalf of the original manager. This feature is available only for users under 
user type manager, when the manager is not available for a certain period of time then the admin can 
bulk redirect the expenses of such managers to available managers for approval. The major advantage of 
this is it helps in cutting delays and keeps the approval process moving ahead the redirected expenses are 
visible to both the original as well as redirected manager, this feature is only for redirecting expenses and 
not transfer of responsibility - it is used as a short-term arrangement. 
 

https://gorillaexpense.freshdesk.com/support/solutions/articles/1000171636-employee-data-import-tutorial
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Figure 9c 

Transfer Approval Responsibility 
 

Using this functionality Admin can transfer approval responsibility from one manager to another by 
selecting the “Transfer Approval Responsibility” link on the Edit User screen, so going forward all the 
original managerial responsibilities are transferred to the new manager. This feature is used when a 
manager leaves the organization and his subordinates are assigned to a new manager, in this case the 
admin can use this feature to allocate the previous /current expenses to the new manager for approval. 
This is a permanent change and cannot be revoked in the system. This functionality is also useful in the 
case when the employee/manager moves from one department/location to another, managerial activities 
and approvals will instantly be taken over by the transferred manager.  
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Figure 9d 

 

Out of Office Settings    
 

This functionality is available only for user type as manager. When the manager is out on vacation or for 
any other business purpose, he/she can enable the out of office settings this then redirects all the 
expenses to the new redirected manager. The admin can also enable the out of office settings on behalf 
of the manager. This feature is time bound and is revoked on the end date to the original manager. It 
gives the flexibility to the manager to redirect the expense reports to his counterpart during vacat ion 
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Figure 9e 
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Reset Password 
 

This is available only for user type as managers this feature helps in individually resetting the password of 
a single user. On choosing this option an email is sent with the new password to the user on the 
configured email id in the application.    
  

 
Figure 9f 

 

Advanced Authorizations  

 
With the help of the Advanced Authorizations the admin console rights can be given to the manager user 
and that user can access the admin menus by switching to the Admin Console. The Admin Console allows 
the user to configure parameters such as create Users, set up Expense Types, Pay Methods, etc. Follow 
the steps given below to provide the Admin Console access to the user.  
 
For providing the access of the admin console to a user, edit the user’s profile. Make sure the user has the 
User Type as Manager, if not then first change the User Type as Manager and Save, then on the user 
profile you will see the link as Advanced Authorizations at the bottom as shown below. 
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Figure 9g 

 

Click on the Advanced Authorizations link, then go to the Admin Authorization tab and select the Admin 
Access checkbox. It will show you ‘Masters’ as the default menu selected under Select Menu Option and 
its associated sub-menus on the popup like below. If you want to provide full admin access (admin access 
to all menus and sub-menus) to the manager user, click on the Save button. 

 

 
Figure 9h 

 

If you want to provide menu-wise admin access i.e. for specific menus => sub-menus then refer to the 
below steps (i, ii, iii) 
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i. Admin access can be set for each of the menus from ‘Select Menu Option’ by selecting a menu for which 
access is to be set and then provide access right to its sub-menus as required. 

 
Figure 9i 

 

ii. You can provide specific access rights on the sub-menus. There are 3 access rights: 
  

• Create, Read, Update, Delete: The manager user will be able to access the sub-menu with full 
access i.e. he can create, read, update and delete the master data of the sub-menu. 

• Read Only: The manager user will be able to access the sub-menu in read-only mode i.e Manager 
user cannot create or update the master data of the sub-menu. 

• None: Manager user cannot access the sub-menu when access right set to ‘None’. 

 
Figure 9j 

 

iii. Click on Save to save the configuration. 
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Figure 9k 

 

Once the user login into the application, the user can switch to the admin console by hovering the cursor 
on the user’s name. 

 
Figure 9l 
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With the help of the Admin Console the user can access admin menus as per the provided rights.

 
Figure 9m 

 
 

Company 
 

In this section, the company name is set up. The initial screen, as shown below in Figure 10 is a list of all 
companies in the system. At the bottom of the page is a Create New Tab. This can be used to create a 
company profile.  
 
 

 
Figure 10a 
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Create New Company 

 
Figure 10b 

 
To add new company, follow below steps and rules 

 Field Description Validation Mandator
y 

Company 
Name 

Enter the Name of the company Alphanumeric, 
with special 
characters 

Yes 

Company code Enter the GL Code of the new company (GP/NAV 
specific field – if you are not using GP/NAV, it can 
be left empty. Populate this field if you have 
company code as part of your GL Account 
segments, while pushing expenses to Great Plains). 
This field can also be used to populate a NAV 
dimension. If this field is enabled the mapping can 
be configured in the integration app 

Alphanumeric, 
with special 
characters 

No 

Company Id  Enter the ID of the new company (GP specific field, 
company ID is the backend value of the company. 
This can be found from SQL server using the 
following SQL- SELECT cmpanyid,cmpnynam,interid                                
FROM dymanics.dbo.sy01500) 

Alphanumeric, 
with special 
characters 

No 

Connection 
string 

Enter the Connection string required to connect to 
the Microsoft GP Web Services – if you are not 
using GP, it can be left empty. 

Alphanumeric, 
with special 
characters 

No 

Logo Enter the Logo of your company. This will be 
printed on the PDF preview of the expense report 

PNG format image 
file 

Yes 

Table 3 
 
 
Edit Company - The pencil icon is for editing the Company 
Delete Company - The Red X is to delete the Company entry. 
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Business Unit 
 
In this section, multiple business units can be set up under different company names, as shown in Figure 

11 a/b 
 
 

 
 

Figure 11a 
 

Create New Business Unit 

 
Figure 11b 

 
 
To add new Business Unit, follow the below Steps/Rules  
 

Field Description Validation Mandatory 
Company Name Select  company if you want the Business 

Unit  to be tied to a specific company   
Alphanumeric, with 
special characters 

Yes 

Business Unit 
code 

Enter the Code of the Business unit 
(Microsoft GP/NAV specific field - This field 
can be user to derive part of the GL 
Account Segment, while pushing expenses 
to GP) This field can also be used to map 
NAV dimension. The actual segment / 
dimension mapping is done in the 

Alphanumeric, with 
characters -special  
Length < =20 

Yes 
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integration app 

Business Unit 
Description 

Enter the Business Unit description Alphanumeric, with 
special characters 

Yes 

 
Table 4 

 
Note:   
1. If the business units are also used within the ERP/Accounting system, it is recommended that the 

entries match here.  
2. Business Unit Codes and Business Unit Descriptions cannot be repeated. If attempted, the application 

will provide an error noting that the entry already exits. 
 
Edit Business Unit: - The pencil icon is for editing the Business Unit 
Delete Business Unit: - The Red X is to delete the Business Unit entry. 

Cost Center 
 

In this section, multiple cost centers i.e. departments can be setup in the application as shown in Figure 
12a  

 
Figure 12a 

 
 

Create New Cost Center 

 
Figure 12b 
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To add new Cost Center, follow the below Steps/Rules  
 

Field Description Validation Mandatory 

Company Select  company if you want the 
cost center to be tied to a specific 
company   

Alphanumeric, with special 
characters 

No 

Business Unit Select  Business Unit if you want 
the cost center to be tied to a 
specific Business Unit   

Alphanumeric, with special 
characters 

No 

Cost Center 
code 

Enter the Code of the Cost Center 
-also, known as Department 
(Microsoft GP/NAV specific field - 
This field can be user to derive 
part of the GL Account Segment, 
while pushing expenses to GP) 
This field can also be used to map 
NAV dimension. The actual 
segment / dimension mapping is 
done in the integration app 

Alphanumeric, with special 
characters 

Yes 

Description Enter the description of the Cost 
Center 

Alphanumeric, with 
characters -special  Length 
< =50 

Yes 

Table 5 
Note: 
1. If the cost centers are also used within the ERP/Accounting system, it is recommended that the 

entries match here for a seamless integration 
2. Cost Center Codes and Descriptions cannot be repeated. If attempted, the application will provide an 

error noting that the entry already exits 
3. For these cost centers to be visible within a user’s or manager’s account, they must be enabled within 

Report Type 
 

Edit Cost Center: - The pencil icon is for editing the Cost Center 
Delete Cost Center: - The Red X is to delete the Cost Center entry 

Country 
 

This feature is available under the Masters -> Country menu. This section lists all the countries available in 
the system. When the Create New button is clicked, the admin can enter new countries. Each country is 
listed with a unique and abbreviated two letter country code. A country can be set to default by clicking 
on the edit button and putting a check in the ‘Set As Default Country’ checkbox. Country Names and 
Country Codes cannot be repeated. If attempted, the application will provide an error noting that the 
entry already exits. 
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Figure 13a 

Create New Country 

 
When the Create New button is clicked admin is presented with the create country screen (Fig 13b), the 
admin can enter fields as detailed in Table 6 

 
      Figure 13b 
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To add new Country, follow the below Steps/Rules  
 

Field Description Validation Mandatory 

Country Name Enter the Name of the Country  Alphanumeric, with 
special characters 
Length <= 20 

Yes 

Country code Enter the Code of the Country  Alphanumeric, with 
special characters 
Length <= 20 

Yes 

Country ISO Code Enter the ISO Code of the Country Alphanumeric, with 
characters -special   

No 

Set As Default 
Country 

Check this checkbox if this country is to 
be shown as default country 

 No 

Table 6 
Note: 
1. If the country is also used within the ERP/Accounting system, it is recommended that the entries 

match here for a seamless integration. 
2. Country Codes and Descriptions cannot be repeated. If attempted, the application will provide an 

error noting that the entry already exits. 
 
Edit Country: - The pencil icon is for editing the Cost Center 
Delete Country: - The Red X is to delete the Cost Center entry 

Currency 
 

This section lists all the currencies available in the system.  
 

 
Figure 14a 
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Create New Currency 

 
When the Create New button is clicked, the admin can enter currency related information in fields 
detailed in Table 7 

 
Figure 14b 

 
Each Currency is listed with a unique and abbreviated three letter currency code. A currency can be set to 
default by clicking on the edit button and putting a check in the ‘Set As Default Currency checkbox’. When 
this box is checked for a particular currency, the status in the Default column will change to True. For all 
other currencies this status will stay as False.  
 
 To add new Currency, follow the below Steps/Rules  
 

Field Description Validation Mandatory 

Currency Type Enter the Type of the Currency Alphanumeric, with 
special characters 
Length <= 20 

Yes 

Currency code Enter the Code of the Currency Alphanumeric, with 
special characters 
Length <= 20 

Yes 

Currency ISO 
Code 

Enter the ISO Code of the Currency Alphanumeric, with 
characters -special   

No 

Set As Default 
Currency 

Check this checkbox if this  
 
Currency is to be shown as default Currency. 
When this box is checked for a particular 
currency, the status in the Default column will 
change to True. 

 No 

 
Table 7 
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Note: 
 
1. If the currency is also used within the ERP/Accounting system, it is recommended that the entries 

match here for a seamless integration. 
2. Currency Codes and Descriptions cannot be repeated. If attempted, the application will provide an 

error noting that the entry already exits. 
3. When a particular currency is set to default, the currency conversion rate in the application will be set 

to 1 when that currency is selected. Note that in the application; only one default currency can be 
setup.  

 
Edit Currency: - The pencil icon is for editing the Currency 
Delete Currency: - The Red X is to delete the Currency 

Currency Rate 
 

Within Gorilla Expense, there are three options to manage the currency rate.  
 
The first option is the standard one where the user manually enters the currency rate for each transaction 
created on the web application or submitted from the mobile app. 
 
The second option is admin can bulk update the currency rate in the system for all the foreign currencies 

using integration app. The following paragraph details the second option. Also, click here for more details 
and the integration app’s currency rate import template.  
 
Using this function, as briefly discussed, the admin can ‘upload’ currency rates for all foreign currencies. 
The admin has the flexibility to allocate different currency rates for different periods. The typical period to 
update the currency rate is on a month-to-month basis. After the currency rates are uploaded 
successfully, when the user changes the currency type in the transaction, the application will 
automatically ‘pull-in’ the respective rate for that currency type relative to the date.  
 
For example, if the currency is EURO and the rates are: 1 EURO= 2.2 USD for the month of April and 1 
EURO=2.5 USD for the month of May. If the user toggles between various dates in April and May, the 
conversion rate field would automatically change between 2.2 and 2.5. Note that, once the currency rates 
are uploaded, they are available to all users. Further, with this option, the user still has the option to 
change the set currency rate manually in the application. However, any changes made by the user to the 
admin defined currency rate will be logged and visible in the Audit Trail for the user, manager and admin 
to see, thus maintaining full visibility for all. 
 
Here are the mechanics to uploading the currency rate - During setup, Gorilla Expense will provide a 
CurrencyRate template document. This is an Excel file with a standard format for listing all the currencies 
and their respective rates. Figure 15 shows an example of a filled CurrencyRate template for the month of  
June, 2013. The multiplier column makes it easy to view the rates without showing too many digits after 
the decimal point.  
 

FromCurrencyID Multiplier CurrencyRate ToCurrencyID FromDate ToDate 

EUR 1 1.245  USD  06/01/13 06/30/13 

EGP 100 14.4785  USD  06/01/13 06/30/13 

ALL 100 0.8891  USD  06/01/13 06/30/13 

ARS 1 0.1891  USD  06/01/13 06/30/13 

AZN 1 1.21  USD  06/01/13 06/30/13 

ETB 100 5.1209  USD  06/01/13 06/30/13 

https://gorillaexpense.freshdesk.com/support/solutions/articles/1000199221-currency-rate-import-templates-
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upload the values contained in this document (Contact Gorilla Expense to learn more about the 
Integration Manager). After logging into the Integration Manager, go to File > Import Currency Rate > 
Import using Excel. Here, click on Settings and browse to the CurrencyRate Excel file and click done. By 
clicking on Reload at the bottom of the page, the entries will be loaded. See Figure 16. Once the entries 
are loaded, click on Select All at the top left (or specif ic Currency IDs) and click on Import Currency Rate(s). 
The Integration Manager will upload the currencies. A green status indicates a success while a red status 
indicates a failed upload. The admin can click on View Log to find the reason for the failed currency rate 
upload. 
 

 
Once this document is filled, the admin will need to use the Gorilla Expense Integration Manager utility to 
Once the currency rate upload is done from the Integration Manager, the admin can go back to the admin 
web application account under Masters > Currency Rate to confirm if the rates have been uploaded. In 
Figure 17 below, as an example, we have selected the Bahrain Dinar currency for the month of June and 
the conversion rate matches row 8 from Figure 16 for confirmation. 
 

 
Figure 16 

AUD 1 0.9774  USD  06/01/13 06/30/13 

BHD 1 2.4745  USD  06/01/13 06/30/13 

BDT 100 1.2148  USD  06/01/13 06/30/13 

BAM 100 63.2698  USD  06/01/13 06/30/13 
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Figure 17 
 

The third option is directly populating the currency rate for all the foreign currencies in the system using 
3rd party API - https://openexchangerates.org 
 

Expense Type 
 

This section lists all the expense types’ setup in the system. As seen in Figure 18a/b, the listed fields 
include Expense Type category, Expense Type, Expense Type Code, Policy Applicable and Policy Limit 
Amount besides the edit and delete buttons. For seamless integration with the ERP/Accounting system, 
the Expense Types and Expense Type Codes setup in those systems must match the types and codes setup 
here. 
 
 

 
Figure 18a 
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Create New Expense Type 

 
When the Create New button is clicked, the admin can make entries for various fields detailed in Table 8 

 
Figure 18b 

Field Description Validation Mandatory 

Expense Type 
Category  

Enter the category of the expense, similar expenses 
can be categorized together under one heading. 
This is where expenses are tied to specific categories. 
Some of the listed categories are airfare, meals, per 
diem, others etc. 

Alphanumeric Yes 

Expense Type Enter the Type of the Expense, 
 
This is the description/name of the expense type. 
Users will see this within the expense type drop 
down field while creating a transaction 

Alphanumeric Yes 

Expense Type 
Code 

Enter the Code of the Expense, 
 
This is the corresponding code tied to the expense 
type, as defined in the ERP/Accounting system. Users 
of the application will not view this field 

Alphanumeric  Yes 

Policy Check if policy is applicable for the expense type,    Checkbox No 



 
Gorilla Expense Application - Admin Guide 
 

55 / 107 
 

Applicable? 
 

 
This will enable a policy limit for the expense type 

Policy Limit 
Amount 

Enter a policy amount.  
 
The application will enforce this amount only if the 
policy applicable checkbox is checked. 
 
If the policy applicable checkbox is checked and if the 
amount has been exceeded, a user will have to enter 
additional comments in the transaction screen 

 No 
 

Receipt Policy 
Applicable? 

Check if receipt policy is applicable for the expense 
type 
This will enable a receipt policy limit for the expense 
type 

Checkbox No 

Receipt Policy 
Limit Amount 

Enter receipt policy amount.  
 
The application will enforce this amount only if the 
receipt policy applicable checkbox is checked. 
 
If the receipt policy applicable checkbox is checked 
and if the amount has been exceeded, a user will 
have to enter comments in the transaction screen, if 
receipt is not attached 

 No 

Mileage Expense 
Type 

Check if the expense type is Mileage Expense type 
 
If this box is checked, the particular expense type will 
be listed as mileage type expense and the application 
will insert the mileage amount from a user’s profile  

Checkbox No 

Alternate 
Amount Label 

Enter the alternate label required for the amount 
label 
 
The admin can change the label of the amount field 
on the expense transaction screen 

 No 

Alternate Rate 
Label 

Enter the alternate label required for the rate label 
 
The admin can change the label of the rate field 

 No 

Enable 
Multiplier? 

Check if Enable Multiplier 
 
This is mainly related to Hotel Expense. If this field is 
enabled then it the Number Of Days field is visible on 
the expense transaction screen. This field can be 
used to capture the number of days over which the 
hotel expense was split – thus enabling to capture 
room rate per night. 

Checkbox No 

Disable 
GST\VAT? 

Check if GST\VAT is to be disabled 
 
If this is checked then the GST/VAT fields will not be 
displayed on the expense transaction screen. This 
should be checked for certain expense types like 
mileage 

Checkbox No 

Enable Attendee 
Tagging? 

Check when need to tag the attendees to the 
Expense Type Meals.  

Checkbox No 
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Table 8 

 
Note: 
 
The example expense type is listed as mileage in description and the expense type GL code is 8530 per the 
accounting system. The policy has been enabled for this expense type and the policy amount is $100. If  a 
user submits a transaction for mileage expense type greater than $100, then the application will mandate 
the user to enter additional comments explaining the reason for exceeding the policy.  
 
Per the alternate labels defined below, when a user selects the Mileage expense type within a 
transaction, the amount field label will change to Distance and the Rate field will change to IRS Rate. The 
IRS Rate field will be pre-populated with the mileage rate as defined in the user’s profile. The auto 
population of the mileage rate is only enabled when the Mileage Expense Type box is checked and it is 
typically used only for the mileage type expense. 
 
Edit Expense Type: - The pencil icon is for editing the Expense Type  
Delete Expense Type: - The Red X is to delete the Expense Type 
 
 

Bulk upload the Expense Type 

 
Using the Gorilla Integration app admin can bulk upload the Expense Types in the system. For more 
details on how to upload the Expense Types using the Integration app please click here.  
 
 

Attendee Tagging 

 
Attendee feature lets the user track people who were part of a Meals Expense. It lets the user tag the 
Attendee's First Name, Last Name, Title, Organization, and Type (Client, Colleague, etc)  
 
The Attendee(s) feature can be enabled while creating New / Editing the expense type with Expense Type 
Category Meals. Then enable the Enable Attendee Tagging and Detailed Attendee Tagging on expense 
type as shown in the figure below. If Enable Attendee Tagging is Enabled and Detail tagging is disabled 
(i.e. selected the Simple Textbox) then it shows the text box for the tagging the attendees on the Expense 
line. 
 
Once the feature is enabled, the user can go to the Add New/Edit Expense screen, as the user selects 
Expense Type with category 'Meals' then he/she can see the Add/Edit attendee(s) link as shown in the 
Figure 18d. 

 
This field is visible when the Expense Type is selected 
as Meals.  

Enable Budget 
Tracking? 

Check if need to maintain the Budget tracking Radio button No 

https://gorillaexpense.freshdesk.com/support/solutions/articles/1000172006-expense-type-data-import-tutorial-
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Figure 18c 

 

 
Figure 18d 
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Budget Tracking 

 
Enabling the Budget Tracking for the expense type lets you define budgets for a defined calendar period. 
You can assign budgets to each expense type for each user or for each expense type at the system level 
(i.e. all users charging to that expense type share a common budget)  
 
Click on the Enable Budget tracking checkbox, it will show you the fields for budgeting. 

 

 

Description of the Enable Budget Tracking Fields: 
 
 
Budget Amount: This field specifies the budget associated with this particular expense type. The budget 
can be specified in foreign currency as well.  
 
Local Currency: Currency selection is given as it defaulted to the system currency but the user can change 
as per requirement. 
 
Conversion Rate: Defaulted to 1. This field is used when you want to track the budget in foreign currency. 
 
Converted Budget Amount: Budget Amount field converted into Amount in the local currency specified in 
the local currency field. Unless you are specifying Budget Amount in a foreign currency.  
 
Budget Applicable: Enter System or User value to indicate if the budget is applicable for this expense type 
across the entire system for all users combined or if the budget is applicable for this expense type for each 
individual user. Also, if that budget is for per user per month or per user per day. If you select the option 
PerUserPerMonth then you can set the monthly budget and if you select the option PerUserPerDay then 
you can set the daily budget. 
 
Budget Period Start Date: The Budget will be applicable from the Start Date. 
 
Budget Period End Date: The Budget will be applicable until the End Date. 
 
Fill-up the required fields and click on the " Create" button to create the Expense Type with the Budgeting 
feature. 
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Figure 18e 

 

 

 



 
Gorilla Expense Application - Admin Guide 
 

60 / 107 
 

 
Figure 18f 

 

Once you have created the expense type with the budget then the user will get the  Remaining Budget link 
on Add / Edit Expense pop-up screen. 

 
Figure 18g 
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If you click on the Remaining Budget link then it will show you the remaining budget for the selected 
expense type as shown below. 

 

 
Figure 18h 

 

Per Diem 
 

Per Diem feature is specific to certain companies who prefer to pay a lump sum amount to their 
employees for expenses incurred during official travel, this saves the employees the hassle of keeping 
track of expenses and simplifies the book keeping entries for the company. The per diem amount is fixed 
according to the city of visit and can vary for different cities. For this feature to work Admin needs to 
configure the expense category = Per Diem, this can be accessed from Masters -> expense types -> create 
link.  In addition, the city – per diem rates need to be maintained, as shown in the next section called City 
Master. Once these two things are done, upon selection of a Per Diem expense type, the city field on the 
expense transaction level will change to a dropdown field that will list all the various cities maintained in 
the City Master. Below figure-18h shows Per Diem California expense type created.  
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Figure 18i 
 

On successfully being created the expense type should be displayed in the expense type list. Below figure-
18j shows the Per Diem California expense type listed.  

 
Figure 18j 
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Below figure 18k shows how the city field will be enabled as a dropdown at the transaction level  
 

 
Figure 18k 

City Master  

 
This feature helps in defining the per diem rates corresponding to cities. This can be done from Masters -
>City -> Create New. Admin needs to update the city name, Currency Type and Per Diem Rate. See figure 
18l for the list of cities with currency type and per diem amount, Figure 18m shows how a new city with 
city name, currency type and per diem rate is created. 

 
Figure 18l 
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Figure 18m 

GSA Per Diem 

 
GSA Per Diem is a daily allowance given to the employees to cover their business trip expenses, based on 
the General Service Administration (GSA) Per Diem rates. Gorilla Expense now supports this feature. 
Based on the location selected by the user, we pull in the corresponding GSA rate from GSA's website in 
real-time. This way the customer only has to do a one-time configuration and no ongoing maintenance of 
GSA rates is required. 
 
To use this feature, the admin needs to add the per diem expense types with respective expense 
categories. The per diem categories are: 

a. Per Diem MIE Total GSA 
b. Per Diem Breakfast GSA 
c. Per Diem Lunch GSA 
d. Per Diem Dinner GSA 
e. Per Diem Incidental GSA 
f. Per Diem Lodging GSA 

 
For creating a new per diem expense type, select the required per diem category in the Expense Type 
Category field. For example, to add the expense type as Lunch/Mid-Day Meal need to select the 
respective per diem category which is Per Diem Lunch GSA. Then fill-up the required fields and click on 
the "Create" button to save the details.  
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Figure 18n 

 

Once you have created the per diem expense type then while creating the New Expense then that time 
the per diem rate will get populated after selecting the per diem expense type, State, and the city.  
 

 
Figure 18o 
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Mileage Addresses  
 

Mileage Address feature is specific to certain companies requiring special mileage restrictions for their 
employees within the USA. These restrictions limit the users to get reimbursed only for distance travelled 
between certain pre-defined addresses. This section will detail how you can create a list of pre-defined 
addressed and then the Mileage addresses & distance mapping will detail on how you can assign pre-
defined distances between any two addresses This section lists all the mileage address setup in the 
system. As seen in Figure 19 a/b 
 

 
Figure 19a 

 
 
Create/Edit New Mileage address 
 
When the Create/Edit button is clicked, the admin can make entries for various fields as detailed in table 9 
 

 
Figure 19b 

 
 

Field Description Validation Mandatory 

Address Enter the Mileage Address, 
 
This is the actual address. It has to be a 
valid address for Google Maps to work 
and the route to be drawn on the google 
maps 

Alphanumeric  
 
Length <=100 

Yes 

Address 
description 

Enter the Mileage Address description 
 

Alphanumeric-  
 

Yes 
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This is the description of the address  Length <=100 

 
Table 9 

Edit Mileage Address: - The pencil icon is for editing the Mileage Address 
Delete Mileage Address: - The Red X is to delete the Mileage Address 
 

Mileage Addresses & Distance Mapping  
This section lists all the distance between various pairs of Mileage address. Refer figure 20a/b  
 
 

 
Figure 20a 

 
 

Create New Mileage address mapping 

 
When the Create New/Edit button is clicked, the admin can make entries for various fields as detailed in 
table 10 

 
Figure 20b 

 
 

Field Description Validation Mandatory 

From Address Select the From Mileage Address 
This is the address from which the distance is to be 

  Yes 
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calculated 

To Address Select the To Mileage Address 
This is the address To which the distance is to be 
calculated 

  Yes 

Distance Enter the Distance 
This is the distance between From and To Mileage 
address 

Numeric up to 2 
decimal numbers 
Value > 0 

Yes 

 
Table 10 

 
Edit Mileage Address mapping: - The pencil icon is for editing the Mileage Address 
Delete Mileage Address mapping: - The Red X is to delete the Mileage Address 

Report Type 
 

In this section, multiple report types can be setup in the application by the admin. These report types are  
seen in the user’s account in the web application at the header level of a report. Dependin g on the Role 
Report Type Mapping setup in the user’s profile (see Role Report Type Mapping below), all or only se lect 
report types will be available to the respective user. Figure 21 shows example report types.  
 

 
 

Figure 21 
 

When the Create New button is clicked, the admin can associate attributes to the report type. In the 
Report Type field, the admin can provide a name for the report type. This is what the users will see when 
selecting from a list of report types. 
In the Sub-Report Type field, the admin can choose an entry from a drop-down list. There are four 
options. They are: 

1) NOCOSTALLOC: If this is selected, the report type will not include the cost allocation feature (for 

more information see COSTALLOCATION below) 

2) PREAPPROVAL: If this is selected, the report type is defined as a pre-approval type report. In this 

report, the user typically submits trip related information and estimates for the trip before it has 

begun 

3) COSTALLOCATION: If this is selected, the report type will include the cost center allocation 

feature. In the web application, when an expense report is created, the user will see a Cost Center 

Allocation button at the top right of the expense report, adjacent to the PDF Preview button. 

When it is clicked, the user will be presented with a pop-up screen where the user can choose to 

allocate a percentage of the transactions that belong to the expense report to different cost 

elements, Project Numbers, Departments etc. Figure 22 shows the allocation to different cost 
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centers for two transactions that are part of an expense report. The total allocation must equal 

100%. If not, the application will provide an error.  

 
4) The entries under the Company, Business Unit, Cost Accounting, Cost Accounting Value and 

Percentage fields can either be selected from a list that has been entered by the admin or the 

user can choose to type values within open text fields. Once the Save button is button is clicked, 

the expense report will show the Cost Allocation pie-chart icon at the transaction level as shown 

in Figure 23. When the pie-chart is clicked, a pop-up screen provides the key details. 

 

 
Figure 22  

 

 

 
 

Figure 23 
 

 
5) HCP (Health Care Provider): If this is selected, the report type will include a HCP cost center 

allocation feature. This feature is typically only utilized by Pharmaceutical, Bio-Tech and Medical 

Device companies to comply with the Physicians Payment Sunshine Act that is part of the 

Affordable Care Act. 

 
In the web application, when an expense report is created, the user will see an HCP Cost Center 
Allocation button at the top right of the expense report, adjacent to the PDF Preview button. 



 
Gorilla Expense Application - Admin Guide 
 

70 / 107 
 

When it is clicked, the user will be presented with a pop-up screen where the user can choose to 
allocate a percentage of the transactions that belong to the expense report to different NPI 
(National Provider Identifier) numbers. Gorilla Expense integrates with a NPI database to provide 
the latest list of NPI numbers within the system. 

 
6) The final field under Create Report Type is Project Type. Here the admin is presented with two 

options: Non–Billable and Billable. If the Billable option is selected the report type qualifies as a 

billable status. So any reports that are set to this report type are pushed to the ERP/Accounting 

system, transactions within these reports will be listed as billable status within the 

ERP/Accounting system if the feature exists in the ERP/Accounting system. 

Report Type Mapping 
 
In this section, additional fields can be enabled or disabled at the header level and transaction level of  an 
expense report for a certain report type. The setup can be done differently for different report types. The 
admin will first need to select a report type from the drop down. Once this is done, the admin can either 
setup the header level fields by clicking on the Header Details button or setup the transaction level f ie lds 
by clicking on the Expense Details button. Figure 24 shows the first screen the admin will see in this 
section.  
 

 
 

Figure 24 
 

 
When the Header Details button for a particular selected Report Type is clicked, Figure 24 is seen. The 
main fields here are: 
 
Job/Project Number: This field refers to job or project numbers defined in the system by the admin. ( See 
Job/Project Number section below for more details)  
 
Class/Customer: This field refers to classes or customers defined in the system by the admin. ( See 
Class/Customer section below for more details)  
 
Ref/Invoice: This field allows the user to enter a reference or invoice number at the header level of the 
expense report. Depending on the integration requirements, entries in this field can be sent to select 
ERP/Accounting systems. (Contact Gorilla Expense to discuss specific requirements) .   
 
Cash Advance: This field allows the user to enter a cash advance value at the header level of the expense 
report. The same value will also be displayed at the bottom of the expense report, shown as Cash 
Advance, for reconciliation purposes.  
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Figure 25 

 
The checkboxes in the ‘Show Field? ’ column will enable these fields when checked or disable them when 
unchecked. As the name suggests, the Mandatory and Optional columns will make the fields mandatory 
or optional for the user to make entries; when the respective radio button is selected. If the field is made 
mandatory and the user does not make an entry, the application with provide an error message 
prompting the user to enter information.  
 
The Enforce Validation column only applies to the Job/Project and Class/Customer fields and the check 
box will become visible when these fields are enabled. When the Enforce Validation is checked, the users 
will only be able to make a selection from a pre-defined list that has been setup the admin in the 
respective sections.  
 
If this is unchecked, the user will not only be able to select from a list of pre-defined entries but also add 
new entries if needed. These new entries are then registered in the system for future use. 
 
When the Expense Details button is clicked, Figure 26 is seen. The main fields here are:  
 
Project Task: This field allows the user to enter a project task value. The field allows for alphanumeric 
entries 
 
Other Co-Workers: This field provides a list of other co-workers setup in the application. The list of co-
workers is sorted alphabetically. The user can choose to select multiple co-workers from the list. The user 
can also add a new co-worker on the web and mobile applications. 
 
Other Comments: This field allows the user to enter additional comments for a transaction.  

 
Figure 26 
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The checkboxes shown next to the fields will enable these fields when checked or disable them when 
unchecked. As the name suggests, the Mandatory and Optional columns will make the fields mandatory 
or optional for the user to make entries; when the respective radio button is selected.  If the field is made 
mandatory and the user does not make an entry, the application with provide an error message 
prompting the user to enter information. 

Role   
In this section, multiple roles can be defined in the system. The function of a role is very similar to 
maintaining various ‘workgroups’ where different attributes can be assigned and invoked to these 
different groups. 
 
The admin can then assign a role to an employee in his/her respective user’s profile. Using this function, it 
is clear that different employees can be setup differently using these different roles. An example is 
provided below for more clarity. Figure 27 shows a sub-set of various roles setup in the example 
application. 

 
Figure 27 

 
In this example, there are three roles defined – Corporate, Project and All. The Corporate role  is def ined 
as a standard role while the Project role has additional parameters setup. The All role includes both 
Corporate and Project. This will be apparent in Role Report Type Mapping (see description of this section 
below) where the All role has both Corporate and Project report types enabled. Employees whose user 
profiles have ‘All’ selected under the Role field will therefore have access to both Corporate an d Project 
report types in the web application. Conversely, if the employee’s user profile has either Corporate or 
Project roles selected, only the respective report type will be available to the user for selection.  
 
Beyond the report type, the role function also allows the admin to setup additional fields within the 
expense at the transaction level. This is described in more detail under Role Expense Detail Mapping 
below. 
 
Edit Role: - The pencil icon is for editing the Role 
Delete Role: - The Red X is to delete the Role 

Role Expense Type Mapping (Optional) 
In this section, various expense types that have been defined in the application (See Report Type & Role 
sections above) can be assigned to roles. Any user who is assigned to a specific role will only see the 
expense types associated with that role. If no expenses types are associated, then the user will see all 
expense types (which is also the default behavior)  
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Figure 28 
Map Expense Types to Role 
 
When the Get Expense Type Details Button is clicked, the admin can select the Expense type to be 
mapped to the role selected 
 

 
Figure 29 

 

Role Expense Type Detail Mapping 
In this section, additional fields can be enabled at the expense transaction level. The maximum number of  
fields that can be enabled is eight. These fields can be enabled differently for different roles that are setup 
in the application (See Role section above). These fields are shown in the application to the 
users/managers based on their roles and if the role they belong to have these fields enabled.  
 
Map Expense details to Role 
The available fields are shown on the list. To change the labels for these fields, see the Configure Label 
section below. The Enable checkbox column next to the field labels will enable or disable the fields. 
Similarly, by checking the Mandatory column checkbox the respective fields will be made mandatory for 
the user to enter data. If not checked, the field will be optional.  
 
If the “Add to Amount” column is checked for a field, the value entered in that field will be added to the 
value entered in the Amount column.  
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Similarly, if “Multiply By Amount” is chosen from the dropdown, the value entered into this field, will 
always be multiplied by Amount field on the transaction screen.  Pre-requisite to choose “Multiply By 
Amount” would be existence of at least one expense type that has “Enable Multiplier” flag checked.  
 
The final column is Data Type, where the admin can choose from four options – Decimal, Text, Integer and 
Date. The data entered in the field can be set to one of these data types (This field is deprecated –  going 
forward the first 4 fields in the list will always be decimal typically used as tax or tips related fields and the 
last 4 will always be text related to city, state, country and vendor) 

 
Figure 30 

 

Role Report Type Mapping 
In this section, various report types that have been defined in the application (See Report Type & Role 
sections above) can be assigned to roles. The report type assignment to a role can be single or multiple 
report types. As a typical example, let’s say a company has defined two report types - Corporate and 
Project. Now the company may create three different roles – Corporate, Project and All. In the Corporate  
role, the corporate report type is assigned. In the Project role, the Project report type is assigned. In the 
All role, the Corporate & Project report types are assigned. Now, when a user’s profile is assigned the All 
role, that particular user will have the choice of both Corporate and Project report types. Figures 31a and 
31b illustrate the example. 
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Figure 31a 

 

 
Figure 31b 

State    
This section lists all the states available in the system. States can be tagged on each transaction and this 
field can be configured to be enabled or disabled to be optional or mandatory using the ‘Role Expense 
Type Detail Mapping’  
 
The State master can also be alternatively used to mark a transaction Billable or non-Billable. In order to 
use the state master as Billable/non-billable, Gorilla Expense Team will setup the configuration labels  and 
clean up existing states 
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Figure 32a 

Create New State 
 
When the Create New button is clicked, the admin can enter the details of the State 
 

 
Figure 32b 
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Field Description Validation Mandatory 

State Name Enter the name of the State 
 
This is the name of the state  

 Alphanumeric 
 
Length <=20 

Yes 

State Code Enter the name of the State 
This is the typically 2 digit code of the 
state. The state code is usually mapped 
with the credit card import state field. 

Alphanumeric 
 
Length <=20 

Yes 

 
Table 11 

Note: 
1. State Name and State Codes cannot be repeated. If attempted, the application will provide an error 

noting that the entry already exits. 
 
Edit State: - The pencil icon is for editing the state 
Delete State: - The Red X is to delete the state 

Status  
 
The status section is where the admin can include status levels and messages for the expense report 
submission and manager approval processes. Figure 33a shows the typical status levels followed by Table  
4 which describes the statuses. Note that statuses are only applicable to the entire expense report and 
not for individual transactions. Figure 33b shows the details of the Manager Approved – Level 1, as an 
example, followed by descriptions of the various fields .  

Figure 33a 



 
Gorilla Expense Application - Admin Guide 
 

78 / 107 
 

 
 

   

 

Field Description 
Saved Not Submitted This is the status when an employee creates an expense report in the application 

Submitted to Manager This is the status when an expense report is submitted to the manager 
Manager Rejected This is the status when an expense report is rejected by a manager 

Manager Approved 
Level – 1 

This is the status when an expense report is approved by the 1st level manager. 
Additional statuses such as Manager Approved – Level 2 and so on can be created if 
there is more than one manager in the system. If there are additional levels of manager 
approvals setup in the system, additional statuses must be created and correctly applied. 
Otherwise, users and managers will receive errors in the application during expense 
report submission and approval 

AP Rejected This is the status when AP rejects an expense report 

AP Approved This is the status when AP approves an expense report 
Forwarded This is the status when an expense report is forwarded to another manager 

AP Paid This is the status when AP has paid the employee per an expense report 
AP Submitted This is the status when AP has submitted the expense report to the Accounting system 

Manager Approved – All 
Levels 

This is the status when an expense report is approved by the final manager 

 

Table 12 

 
Figure 33b 
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Category 
 
Different statuses can be categorized to different user types depending on the next action to be taken 
with that report. In the example shown in Figure 19, the Manager Approved – Level 1 is categorized to 
Manager, since the next action is for the final manager to approve the report. Similarly, the Manager 
Rejected status is categorized as Employee because the next action in case of a rejection is for the 
employee to fix the report per the rejection comments. All the AP statuses shown in Figure 18 with the 
exception of AP Rejected are categorized to the Admin type user since the admin needs to take next 
action with the reports. The AP Rejected is categorized to Employee.  
 
Status 
This field lists the name of the status 
 
Email Subject 
 
This field is the subject line of the email sent to the users (employees and managers) when the status of  a 
report is changed. All statuses in the system have an email subject with the exception of the Saved Not 
Submitted status. 
 
Email Body 
 
This field is the body of the email sent to the users (employees and managers) when the status of a report 
is changed. The admin can tweak the content as needed.  
 
Next Approval Status 
 
This field shows the next approval status following the current status. In this example, after the Manager 
Approval – Level 1 is complete, the report is sent to the next and final manager.  When the final manager 
approves the report the status is changed to Manager Approved – All Levels as shown.  
 
Next Rejection Status 
 
Similar to the previous paragraph, this field shows the next rejection status of the expense report 
following the current status. In this example, if the manager chooses to reject the report, it is sent back to 
the employee and the status is changed to Manager Rejected as shown.  
 
Initial Status for Pre-Approval 
 
In the application certain report types can be defined as pre-approval, where the employee can submit a 
pre-approval report with trip related information and estimates for the trip before it has be gun. If this 
field is checked, the application will assign the respective status as the initial status for pre -approval.  
 
Initial Status 
 
This field assigns the initial state to the respective status, if the box is checked. This means the report is 
saved in the user’s profile with no action taken on it yet. Looking at Figure 18, typically, the Saved Not 
Submitted status is assigned to initial status.  
 
Final Pre-Approval Status 
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In the application certain report types can be defined as pre-approval, where the employee can submit a 
pre-approval report with trip related information and estimates for the trip before it has begun. If this 
field is checked, the application will assign the respective status as the final status for pre -approval, thus 
closing the pre-approval report type from any further action. Only an admin type user can make changes, 
reject or modify statuses to a report that has the Final Pre-Approval Status 
 
Final Status 
 
This field assigns the final state to the respective status, if the box is checked. This means the report is 
completed its course and is now available to be pushed to the ERP/Accounting system by the admin. 
Looking at Figure 18, typically, the Manager Approved – All Levels status is assigned to final status. Only 
an admin type user can make changes, reject or modify statuses to a report that has the Final Status.  
 

Configure Label 
This feature is available under the Masters -> configuration label menu. In this section, the labels for 
various fields at the transaction level of an expense report can be configured to be unique. This includes 
the four fields from Role Expense Detail Mapping, besides City, State, Project Task and Other Comments. 
The labels can be changed to match the desired function of these fields. 
 

 
Figure 34 

 
An example is shown above where four Misc Amount fields are used to report different VATs; the Project 
Task field is labeled as Job and the Other Comments field is labeled as Other Comments. The labeled 
names are what the users of the application will see within their transactions.  
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Pay Method 
This feature is available under the Masters -> Pay Method menu. In this section, various pay methods can 
be setup in the application. Generally, pay methods fall into two categories – Cash and Corporate Card.  
 
The cash pay method corresponds to reimbursable transactions (also commonly referred to as out -of-
pocket), while the corporate card corresponds to non-reimbursable transactions. Multiple corporate card 
pay methods can be created if more than one corporate card is used.  
 

 
Figure 35 

 
When the Create New button is clicked, the admin is presented with a screen to enter values. Figure 36a 
shows an example pay method created for a corporate card from American Express while Figure 36b 
shows an example pay method created for cash-based transaction. 
 

                         

 
Figure 36a 
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Figure 36b 

 
The Method Name entered will be visible to the user in the drop-down list under Pay Method within a 
transaction in the application 
 

- The Method Code corresponds to the corresponding code for that pay method that is setup in the 

ERP/Accounting system. Typically for the cash type pay method this code defaults to the 

employee’s ID/user code (no admin intervention is needed. The application defaults that 

automatically during integration) 

- The Reimbursable checkbox establishes if the particular pay method is reimbursable. Typically for 

the cash type pay method, this is checked 

- The Set As Default Method checkbox sets up the particular pay method as the default. Only one 

default can be setup at a time 

Vendor 
 

This feature is available under the Masters -> vendor menu. In this section, a canned list of frequently 
used vendors is provided. From here, the admin may choose to create a new vendor, edit existing vendors 
or delete vendors as needed. 
 
In the application, when the user starts typing the name of a vendor within a transaction, the application 
will ‘pull’ in vendors from here and provide them in a list to choose from that is sorted alphabetically. If 
the typed vendor does not exist in the list, the user can optionally add the vendor (This feature has to be 
enabled or can be disabled if currently enabled) 
 
When the user adds a new vendor, it will be registered here for future use and will also be made available  
to all users using the system. 
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Figure 37 

 

Bank Comment Mapping 
This feature is available under the Masters ->Bank Comment Mapping menu. The Bank Comment 
Mapping section is relevant to customers importing AMEX or MasterCard or Visa credit card feed into the 
system. The section allows the administrator to auto-map expense type and vendor fields using 
description column in the feed. For example, if in the credit card feed, in the respective transaction 
description field you have a description that says “Hilton”, the admin can map it to expense type “Hotel” 
and vendor “Hilton”. Similarly, a keyword like Airlines can be mapped to Expense Type “A irfare”. 
 If the credit card feed provides a category column, the admin can map broader category to an expense 
type. For example, category of “Accommodation” can be mapped to Expense Type “Lodging” Or “Hotel”. 
This way fewer mapping entries will have to be maintained by the admin. 
 
Similarly, if the credit card feed provided Vendor details, we can map this information to auto -create 
vendor if it does not already exist. To enable this feature, you may leave the vendor field empty during 
the mapping and contact Gorilla Expense Team. The downside to this would be that the system will create 
vendors as they appear in the credit card feed. 
 
Figure 39 a/b shows the screens relevant to Bank Comment Mapping 
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Figure 38 

Create New Bank Comment 
 

When the Create New button is clicked, the admin is presented with a screen to enter values. Figure 39 
shows an example bank comment mapping created for expense type “Computer software, licenses & 
maintenance” for vendor “Walmart”.  

 
Figure 39 

 

Field Description Validation Mandatory 

Comments Enter the comments of the Vendor Alphanumeric, with 
special characters 

Yes 

Expense type Select the expense type  Yes 

Vendor name Select the vendor name   Yes 

 
Table 15 

Tax Rate 
 

This feature is available under the Masters -> Tax Rate menu for user type as admin.  
 
This feature is relevant to customers who are looking to auto calculate and pre-populate tax rates for 
specific states or mapped to specific expense types. By doing this it eliminates the users from calculating 
and entering the taxes in the respective field which can be enabled as a mandatory field, when the 
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organization wishes to track the various taxes for state or federal reimbursements. From the user’s 
perspective it makes it easier because the taxes are auto calculated and prepopulated in the respective 
fields and saves them time and effort in calculations. From the admins perspective they are in total 
control of the tax rate and changes to it if required.  
 
The Tax Rate screen lists the Tax Rate Data that have been set up in the system. These tax rate data are 
mapped to the states and can be mapped to specific expense types, which is optional. When the tax rate 
data is not mapped to any specific expense type then it will be applicable for all the expenses when that 
particular state is selected for the corresponding valid time period for e.g. in Figure 40 below, tax rate 
data for BC will be applicable when any expense type is selected  with BC as the selected state. The 
configured data on tax rate for state, expense type, time period etc. will be auto calculated and populated 
on the transaction screens, using the transaction amount as the basis for the calculation.  This will also be 
displayed on the edit expense transaction screen, on all add new transaction screen (available on Create 
expense report screen as well as Expense Reports-> Transaction screen).  
 
The admin can enable/disable up to 4 tax rates. For these tax rates to be visible on the expense 
transaction screen they should be enabled from the role expense detail mapping. Even if all 4 tax rate 
fields are enabled, it is not necessary to enable auto-tax rate calculations on all 4 tax fields. This can be 
configured by checking the check box next to each tax rate file (as shown in Figure 40b).  The tax rates 
defined are time bound and have a valid from and a valid to date. Tax rates can be defined in the system 
using the Create New action link. The initial screen, as shown in the below figure (40) lists the tax rate 
data available in the system. 
  
 

 
Figure 40 

 
Edit Tax Rate Data: - The pencil icon is for editing Tax Rate Data. 
Delete Tax Rate Data: - The Red X is to delete the Tax Rate Data. 

Search button  

Tax Rate Data(s) already existing in the system can be searched with the “Expense Type”, “State”, “Valid 
From” or “Valid to” dates using the search button. Below screen (Fig 40a) shows the search process of Tax 
Rate Data(s). 
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Figure 40a 

Create New  

When the Create New button is clicked, the admin is presented with a screen to enter values. Figure (40b) 
shows an example tax rate created for an expense type “Cell Phone” mapped to state “QC”.  
 

 
Figure 40b 

Figure 40c shows the auto calculation and auto population of tax data for state “BC” and expense type 
“Cell Phone” and added to the transaction amount.                      
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Figure 40c 

 

Violation 
 

This feature is available under Masters -> Violation menu. The Violation functionality is not enabled by 
default, admin needs to raise a specific request with Gorilla Expense to turn the feature on. When the 
settings for this feature is successfully enabled, the following menus will be activated and visible under 
the Master menu 
 

• Violation 

• Expense Type Violation Mapping (Optional) 
 
This feature is relevant to customers who are looking to provide specific violation reasons to be chosen by 
the user. By doing this it eliminates the users from entering irrelevant reasons/data in the “Other Details” 
field which is a mandatory field, when a violation occurs. From the user’s perspective it makes it easier for 
them to choose from predefined messages provided in a drop down rather than constructing one . The 
additional advantage of this feature is that it helps the admin create granular reports with respect to the 
violation reasons and provides an insight of possible leakages that can be tracked and plugged 
periodically. Also, this will help in bringing about a standardization of the violation reasons and make it 
easier for the Admin to track violations periodically system wide.  
 
 The Violation feature lists the violation reasons that have been set up in the application. When these 
violations are mapped to expenses (refer Expense Type Violation Mapping section for details) the 
violation reasons pertaining to the specific expense will be available to the users in a drop down on the 
“Other Details” field in the create/edit expense transaction screen.  There are two categories of violations 
maintained in the system “Expense” and “Receipts”, admins need to provide specific violation reasons to 
each of this category in the Create New action link. The initial screen, as shown in below figure shows a 
list of violation category with their violation reasons.  
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Figure 41 

 
Edit Violation: - The pencil icon is for editing violation 
Delete Violation: - The Red X is to delete the violation 
 

Search button  

Violations already existing in the system can be searched with the violation category and violation reason 
using the search button. Below screen (Fig 42) shows the search process of violations 

 
Figure 42 

 

Create New  

When the Create New button is clicked, the admin is presented with a screen to enter values. Figure 43a 
shows an example violation created for an expense while Figure 43b shows an example of violation 
created for a receipt. 

 
Figure 43a 
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Figure 43b 

 

Expense Type Violation Mapping  
 

(Optional) This feature helps in mapping the relevant expense policy violation reasons to corresponding 
expense types. This is not a mandatory thing to do - if this mapping is not mapped, by default, the list of 
all violation reasons will be available for every expense type. 
 
From the “Expense Type” dropdown select the desired expense type for which the violation reason(s) 
need to be assigned. Then select violation reasons from left list box and use button “>>” to put the 
selected violation reasons under assigned violation reasons list box and click save button as shown in 
below figure. On clicking save the assigned violation reason will tie up to the selected expense type. 

 
 

Figure 44 
The violation reasons would be visible to the user on the transactions screen in the “Other Details” as a 
drop down these reasons are totally customized according to the expense type and would vary according 
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to individual company processes, these violation reasons will be maintained in the violation master and 
they can be mapped individually to expense types.  

 
Figure 44 

Project Masters 
 

The Project Masters button when clicked expands into multiple fields. This is where various parameters 
specific to various projects are defined and stored within the application.  During initial setup of the 
application, Gorilla Expense will setup certain parameters per the requirements of the customer. 

 
Figure 45 
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Customer 
Using this function, the admin can ‘upload’ customer data for all available projects. Following are the 
mechanics to uploading the Customer Data - During setup, Gorilla Expense will provide an Import 
Customer template document. This is an Excel file with a standard format for listing all the Customers and 
their details. Below figure shows an example of a filled Import Customers template.  
  

Customer Name  Customer ERPId IsEnabled 

Gorilla Expense GE NO 

Kairee Systems  KS YES 

Tata Consultancy Services TCS YES 

Persistent Systems Ltd PSL YES 

BS&B Ltd BSB YES 

NBS Ltd NBS YES 

Infoware Systems Ltd ISL YES 

Cognizant Ltd. CL YES 

  
Once this document is filled, the admin will need to use the Gorilla Expense Integration Manager utility to 
upload the values contained in this document. After logging into the Integration Manager, go to File - > 
Import Master Data -> Import Customers. Here, select settings menu and browse for the file to be 
imported from the local drive using the Browse option. Select done when the file is selected.  
Select Reload this should populate all the data in the excel sheet, user can select all the records to be 
imported by choosing the “Select All” option or can manually select each record to be imported. 
After selecting the records to be imported User selects the “Import Customer(s)” button on successful 
import the records turn green else in case of unsuccessful import the record turns orange and on hovering 
the incomplete record the reason for failure is displayed else user can choose the “View log“  option to 
ascertain the reason for import failure. 
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After successfully importing Customers, user should login to gorilla expense manager and Go to Project 
Masters -> Customer and check if the imported Customer(s) is/are displayed 

 Figure 46 

Project 
 

Using this function, the admin can ‘upload’ project data for all available projects. Following are the 
mechanics to uploading the Project Data.  During setup, Gorilla Expense will provide an Import Projects 
template document. This is an Excel file with a standard format for listing all the Projects and their details. 
Below figure shows an example of a filled Import Projects template. 
 

Customer ERPId Project Name Project ERPId Start Date  End Date Project Status 

TCS Project1 PRO1 1/1/2015 12/31/2015 Open 

TCS Project2 PRO2 1/1/2015 12/31/2015 Open 

KS Project3 PRO3 1/1/2015 12/31/2015 Closed 

KS Project4 PRO4 1/1/2015 12/31/2015 Inactive 

  
  
Once this document is filled, the admin will need to use the Gorilla Expense Integration Manager utility to 
upload the values contained in this document. After logging into the Integration Manager, go to File - > 

Import Master Data -> Import Projects. Here, select settings menu and browse for the file to be imported 
from the local drive using the Browse option. Select done when the file is selected.  
Select Reload this should populate all the data in the excel sheet, user can select all the records to be 
imported by choosing the “Select All” option or can manually select each record to be imported  
After selecting the records to be imported User selects the “Import Project(s)” button on successful 
import the records turn green else in case of unsuccessful import the record turns orange and on hovering 
the incomplete record the reason for failure is displayed else user can choose the “View log “ option to 
ascertain the reason for import failure . 
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After successfully importing Projects, user should login to gorilla expense manager and Go to Project 
Masters -> Project and check if the imported Project(s) is/are displayed 
 

 Figure 47 

Project Manager Mapping 
Using this function, the admin can ‘upload’ Project Managers data for all available projects. Following are 
the mechanics to uploading the Project Managers Data - During setup, Gorilla Expense will provide an 
Import Project Manager Template document. This is an Excel file with a standard format for listing all the 
Project Manager. Below figure shows an example of a filled Import Project Managers template.  
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Project ERPId UserCode/Email/ Vendor Code IsEnabled 

90000 1235 YES 

90501 3245 YES 

90505 1234 YES 

  
  
Once this document is filled, the admin will need to use the Gorilla Expense Integration Manager utility to 
upload the values contained in this document. After logging into the Integration Manager, go to File - > 

Import Master Data -> Import Project Managers. Here, select settings menu and browse for the file to be 
imported from the local drive using the Browse option. Once the file is selected, click done.  Click Reload 
this should populate all the data in the excel sheet, user can select all the records to be imported by 
choosing the “Select All” option or can manually select each record to be imported . 
 
After selecting the records to be imported User selects the “Import Project Manager(s)” button on 
successful import the records turn green else in case of unsuccessful import the record turns orange and 
on hovering the incomplete record the reason for failure is displayed else user can choose the “View log“ 
option to ascertain the reason for import failure . 

 
  
After successfully importing Project Managers user should login to gorilla expense manager and Go to 
Project Masters -> Project Manager Mapping and check if the imported Project Manager(s) is/are 
displayed 
 

Project - Manager Mapping and Manager - Project Mapping Option 
 

This feature helps in mapping individual Managers to projects or vice versa. Earlier the feature available 
was used for project manager mapping where admin would select the project and assign manager to that 
project, the drawback was that if the Admin had to assign a single manager to multiple projects then it 
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was a tiresome job to select each project and assign the manager to it. With this feature at one go the 
admin can map multiple managers to multiple projects in a single screen 

Project Manager Mapping  

 Figure 48 

 

 
Figure 49 
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Manager Project Mapping 

 
Figure 50 

 
 

 
Figure 51 

Project User Mapping 
 

Using this function, the admin can ‘upload’ Project Users data for all available projects. Following are the 
mechanics to uploading the Project Users Data. During setup, Gorilla Expense will provide an Import 
Project Users template document. This is an Excel file with a standard format for listing all the Project 
Users. Below figure shows an example of a filled Import Project Users template.  
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Project ERPId UserCode/Email/VendorNumber IsEnabled 

90000 ACKE0001 NO 

90000 ERIC0001 YES 

90000 BARR0001 YES 

  
Once this document is filled, the admin will need to use the Gorilla Expense Integration Manager utility to 
upload the values contained in this document. After logging into the Integration Manager, go to File - > 

Import Master Data -> Import Project Users. Here, select settings menu and browse for the file to be 
imported from the local drive using the Browse option. Select done when the file is selected.  
Select Reload this should populate all the data in the excel sheet, user can select all the records to be 
imported by choosing the “Select All” option or can manually select each record to be imported  
After selecting the records to be imported User selects the “Import Project User(s)” button on successful 
import the records turn green else in case of unsuccessful import the record turns orange and on hovering 
the incomplete record the reason for failure is displayed else user can choose the “View log “ option to 
ascertain the reason for import failure . 

 
 
After successfully importing ‘Project Users’ user should login to gorilla expense manager and Go to Project 
Masters -> Project Users Mapping and check if the imported Project Users are displayed 
 

Project-User Mapping  and User-Project Mapping Option 

This feature helps in mapping individual user/s to projects or vice versa. Earlier the feature available was 
used for project user mapping where admin would select the project and assign user to that project, the 
drawback was if the Admin had to assign a single user to multiple projects, then it was a tiresome job to 
select each project and assign the user to it. With this feature, at one go the admin can map multiple 
users to multiple projects in a single screen 
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Project User Mapping 

 
Figure 52 

 

 

 
 

Figure 53 
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Figure 54 

 

User Project Mapping 

 
Figure 55 
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Figure 56 

 

Project Task/Job 
 

Using this function, the admin can ‘upload’ Project tasks for all available projects. Following are the 
mechanics to uploading the Project tasks.  During setup, Gorilla Expense will provide an Import cost 
categories or Project tasks template document. This is an Excel file with a standard format for listing all 
the Project tasks details. Below figure shows an example of a filled Import Project tasks template.  
  

Project 
ERPId 

Project Task 
Name 

Project 
Task 
ERPId 

Task Type  Billing 
Code 
ERPId 

Start 
Date  

End Date Estimated 
Hrs Qty 

Estimated 
Rate Per 
Hrs 

Estimated 
Cost 

PRO1 Requirements 
Analysis 

TSK1 Timesheet N/B 1/1/2015 1/30/2015 10 1 100 

PRO1 Prototype 
development 

TSK2 Timesheet STD 1/1/2015 1/30/2015 200 10 2000 

PRO3 Onsite 
Demo/Works 

TSK3 Timesheet STD 1/1/2015 1/30/2015 200 10 2000 

PRO1 Devlopment 
Tasks 

TSK4 Timesheet N/B 1/1/2015 1/30/2015 100 10 1000 

PRO1 Quality 
Testing 

TSK5 Timesheet N/C 1/1/2015 1/30/2015 50 10 500 
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Once this document is filled, the admin will need to use the Gorilla Expense Integration Manager utility to 
upload the values contained in this document. After logging into the Integration Manager, go to File - > 

Import Master Data -> Import Project Tasks. Here, select settings menu and browse for the file to be 
imported from the local drive using the Browse option. Select done when the file is selected.  
Select Reload this should populate all the data in the excel sheet, user can select all the records to be 
imported by choosing the “Select All” option or can manually select each record to be imported  
After selecting the records to be imported User selects the “Import Project Tasks” button on successful 
import the records turn green else in case of unsuccessful import the record turns orange and on hovering 
the incomplete record the reason for failure is displayed else user can choose the “View log “ option to 
ascertain the reason for import failure . 
 

 
  
After successfully importing Project Tasks user should login to gorilla expense manager and Go to Project 
Masters -> Project Tasks/Jobs and check if the imported Project Tasks are displayed 
 

 
 

Figure 57 
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Project Expense Type Mapping 

 Project - Expense Type Mapping and Expense Type - Project Mapping Option  

This feature helps in mapping individual expense types to projects or vice versa. Earlier the feature 
available was used for project expense type mapping where admin would select the project and assign 
expense types to that project, the drawback was that if the Admin had to assign a single expense type to 
multiple projects, then it was a tiresome job to select each project and assign the expense type to it . With 
this feature at one go the admin can map multiple expense types to multiple projects in a single screen. 

Project to Expense Type Mapping 

 
Figure 58 

 
Figure 59 
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Expense Type to Project Mapping 

 
Figure 60 

 
 

 
Figure 61 
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Role Project Mapping 
Gorilla Expense allows you to map desired projects to the corresponding user roles. This way each user 
will only see the list of projects he or she is authorized to see.  The "Role Project Mapping" and on the Role 
Project Mapping screen, you can map the projects to a particular role.  

 

 
Figure 62 

 

From the "Role" dropdown select the desired user role for which the project needs to be mapped. Then 
select the projects from unmapped projects list box and use button ">>" to map the selected projects 
under the mapped projects list box and click on the "Save" button as shown below. 

 

 
Figure 63



© Copyright 2009-2014 Gorilla Expense | Powered by Gorilla Expense  

Appendix 
 

The following diagram shows the typical expense reporting process -
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Legal Notice  
©2013 Gorilla Expense. All rights reserved. 

This documentation including all documentation incorporated by reference herein such as documentation 
provided or made available at www.gorillaexpense.com is provided or made accessible "AS IS" and "AS 
AVAILABLE" and without condition, endorsement, guarantee, representation, or warranty of any kind by 
Gorilla Expense. Gorilla Expense assumes no responsibility for any typographical, technical, or other 
inaccuracies, errors, or omissions in this documentation. In order to protect Gorilla Expense’s proprietary 
and confidential information and/or trade secrets, this documentation may describe some aspects of  the 
Gorilla Expense technology in generalized terms. Gorilla Expense reserves the right to periodically change 
information that is contained in this documentation; however, Gorilla Expense makes no commitment to 
provide any such changes, updates, enhancements, or other additions to this documentation to you in a 
timely manner or at all.  

This documentation might contain references to third-party sources of information, hardware or 
software, products or services including components and content such as content protected by copyright 
and/or third-party web sites (collectively the "Third Party Products and Services"). Gorilla Expense does 
not control, and is not responsible for, any Third Party Products and Services including, without limitation 
the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, 
decency, links, or any other aspect of Third Party Products and Services. The inclusion of a reference to 
Third Party Products and Services in this documentation does not imply endorsement by Gorilla Expense 
of the Third Party Products and Services or the third party in any way.  

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL 
CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, 
GUARANTEES, REPRESENTATIONS OR WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE 
OR USE, MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, 
OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING OR USAGE OF TRADE, OR 
RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY 
SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, 
ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME 
JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND 
CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING 
TO THE DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE 
LIMITED, ARE HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE 
DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.  

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT S HALL 
GORILLA EXPENSE BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS 
USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY 
THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF 
THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, 
PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO 
REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF 
BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY 
DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH GORILLA EXPENSE 
PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF GORILLA EXPENSE PRODUCTS OR 
SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS 
OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER 
OR NOT SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF GORILLA EXPENSE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 
LAW IN YOUR JURISDICTION, GORILLA EXPENSE SHALL HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY 

http://www.gorillaexpense.com/


 
Gorilla Expense Application - Admin Guide 
 

107 / 107 
 

WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE 
OR STRICT LIABILITY. THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) 
IRRESPECTIVE OF THE NATURE OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT 
NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL 
THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE 
ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREIN; AND (B) TO GORILLA 
EXPENSE AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING 
AIRTIME SERVICE PROVIDERS), AUTHORIZED GORILLA EXPENSE DISTRIBUTORS (ALSO INCLUDING AIRTIME 
SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT 
CONTRACTORS. IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT 
SHALL ANY DIRECTOR, EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF 
GORILLA EXPENSE OR ANY AFFILIATES OF GORILLA EXPENSE HAVE ANY LIABILITY ARISING FROM OR 
RELATED TO THE DOCUMENTATION.  

Installation or use of Third Party Products and Services with Gorilla Expense's products and services may 
require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or 
violation of third party rights. You are solely responsible for determining whether to use Third Party 
Products and Services and if any third party licenses are required to do so. If required you are responsible  
for acquiring them.  

You should not install or use Third Party Products and Services until all necessary licenses have been 
acquired. Any Third Party Products and Services that are provided with Gorilla Expense's products and 
services are provided as a convenience to you and are provided "AS IS" with no express or implied 
conditions, endorsements, guarantees, representations, or warranties of any kind by Gorilla Expense and 
Gorilla Expense assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and 
Services shall be governed by and subject to you agreeing to the terms of separate licenses and other 
agreements applicable thereto with third parties, except to the extent expressly covered by a license or 
other agreement with Gorilla Expense.  

The terms of use of any Gorilla Expense product or service are set out in a separate license or other 
agreement with Gorilla Expense applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO 
SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY GORILLA EXPENSE FOR 
PORTIONS OF ANY GORILLA EXPENSE PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.  
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